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1 Overview

Welcome to Microsoft Office Access 2003!

Welcome to Microsoft® Office Access 2003, a program in Microsoft Office Professional Edition 2003 and Microsoft Office Professional Enterprise Edition 2003 and part of the Microsoft Office System—the easiest way to help more people use information to make a positive impact on business. These Microsoft Office 2003 Editions offer new technologies and features while improving upon existing and familiar tools to facilitate effective and efficient collaboration and information sharing.

Access 2003, the Microsoft Office database management program, provides a powerful set of tools that are sophisticated enough for professional developers, yet easy for new users to learn. Now everyone in your organization can create or use powerful database solutions that make organizing, accessing, and sharing information easier than ever.

Save Time by Organizing Your Information in a Database

A database is a collection of information that is related to a particular subject or purpose, such as tracking customer orders or maintaining a music collection. Everyone has information that can benefit from the structure provided by a database. For example, by entering information about your CD collection into a database on your computer, you can easily use the database to search for common artists, countries, instruments, or songs.

If your database isn’t stored on a computer, or if only parts of it are, you may be tracking information from a variety of sources that you have to coordinate and organize yourself. For example, suppose the phone numbers for your organization’s suppliers are stored in various locations: in a card file containing supplier phone numbers, in product information files in a file cabinet, and in a spreadsheet containing order information. If a supplier’s phone number changes, you might have to update that information in all three places. In an Access database, however, you only have to update information in one place—the supplier’s phone number is automatically updated everywhere you use it in the database.

Using Access 2003, you can manage all your information from a single database file. Within the file, you can use:

· Tables to store your data.

· Queries to find and retrieve just the data you want.

· Forms to view, add, and update data in tables.

· Reports to analyze or print data in a specific layout.

New and Improved Features in Access 2003

Access 2003 is easier than ever for everyone in your organization to use. An improved user experience, automatic error checking, automatic property updating, and the capability to view object dependencies help you work more productively. Export and import data and link to lists on Microsoft Windows® SharePoint® Services sites where other team members can access them. Access 2003 also gives you expanded capabilities to import, export, and work with Extensible Markup Language (XML) data files.

Exchange Data with Multiple Sources

As the industry standard, XML provides a way to help maintain consistency in the table relationships and field properties of imported and exported data.

Access 2003 has improved XML support in the following areas:

· Improved! Export all related details when exporting a report. Access databases are inherently relational, and, therefore, typically have data in related tables. Now, when a report is exported, the related details are also exported.

· Improved! Integrate XML data exported from Access 2003 with larger business processes using the Microsoft Visual Studio® .NET development system. In Access 2003, data type names are synchronized with an updated XML Schema Definition (XSD). XML schemas can now be validated against the current XSD.

· Improved! Transform the XML schema used for a set of data into another schema when importing or exporting that data. An Extensible Stylesheet Language Transformation (XSLT) can be performed when importing or exporting XML data.

· Improved! Export XML data to an HTML file that looks similar to the Access 2003 object. Users can export presentation Extensible Stylesheet Language (XSL) files. Access 2003 uses presentation information in the form, report, or data sheet to generate custom XSL code. The code produces an HTML file that maintains the appearance of the Access 2003 object.

Capture, Present, and Work with Data Efficiently

First introduced with Microsoft Office XP, smart tags enable the dynamic recognition of data within documents and spreadsheets. When data is recognized, users can invoke an action from a list associated with that particular smart tag.

In Access 2003, such actions include inserting relevant data, linking to a Web page, looking up data, and converting data as well as many other actions. Smart tags can be added to any field in a table, query, form, report, or data access page in a database.

     Access 2003 uses smart tags for the following purposes:

· New! Error checking is made easier with smart tags. Access 2003 flags common errors on forms and reports and offers options for correcting them. 
· New! Propagating field properties is as simple as modifying a property in one location and then selecting to propagate the change throughout all controls bound to that field.
In addition to smart tags, Access 2003 incorporates new search and analysis functionality to help users efficiently work with and present data:

· New! The Dependent Objects feature helps you spend less time in routine database maintenance tasks by enabling you to quickly search for tables, queries, forms, or reports that depend on a particular database object. 
Easily Share Information

Microsoft Windows SharePoint Services brings the power of collaborative processes to Access 2003. Data and reports can now be exchanged and automatically updated from a shared location in a way that promotes accuracy and consistency.

Access 2003 enables users to maintain a link between their data and Microsoft Windows SharePoint Services using the following features:

· New! Export the content of a table or query to Microsoft Windows SharePoint Services by selecting the option in the Export dialog box. Users can specify the SharePoint site in the Export wizard.

· New! Import a list to a static table to view and change the data in the table independently of the published list on the SharePoint site. This enables users to analyze data in Access 2003 without interrupting normal operations.

· New! Link a SharePoint list to an Access 2003 table to maintain the data regardless of which application is used for the modification. This enables users to apply business rules to the data using Access 2003 as the front end.

Working with Previous Versions of Access

You can use an Access 2000 database or Access 2000 project in both Access 2003 and Access 2000—even if the file is a security-enabled Access database.

Access 2003 uses Access 2000 as the default file format for new databases, enabling you to deploy Access 2003 in your organization while maintaining compatibility with existing Access users and solutions. This enables your organization to have different versions of Access deployed while using a single database file.

2 Managing Information with Access

Introduction 

Access 2003 provides a powerful set of tools for organizing, accessing, and sharing your information. This section introduces you to relational databases and highlights some of the features that help you work with your data in Access 2003. This section also covers how you can set up your Access 2003 database to interact with other systems using XML, and what you can do to help protect your data.

Building Relational Databases

A relational database is a type of database that stores information in tables, enabling you to use matching values from two tables to relate data in one table to data in the other table.

A table is a collection of data about a specific topic, such as products or suppliers. Using a separate table for each topic means that you store the data only once. This results in a more efficient database and fewer data-entry errors.

After you’ve set up different tables for each subject in your Access database, you need a way of telling Access 2003 how to bring that information back together again. The first step in this process is to define relationships between your tables. After you’ve done that, you can create queries, forms, and reports to display information from several tables at once. For example, you may have an order form that includes information from a Customers table, an Orders table, a Products table, and an Order Details table. The fields in these four tables must be coordinated so that they show information about the same order. This coordination is accomplished with relationships between the tables. A relationship works by matching data in key fields—usually fields with the same name in both tables. In most cases, these matching fields are the primary key from one table, which provides a unique identifier for each record and a foreign key in the other table. For example, employees can be associated with orders they’re responsible for by creating a relationship between the EmployeeID field in the Employees table and the Orders table.

There are three types of relationships in Access 2003:

· One-to-many. A one-to-many relationship, illustrated in Figure 1, is the most common type of relationship. In a one-to-many relationship, a record in Table A can have many matching records in Table B, but a record in Table B has only one matching record in Table A.
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Figure 1. One-to-many relationship
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Many-to-many. In a many-to-many relationship, illustrated in Figure 2, a record in Table A can have many matching records in Table B, and a record in Table B can have many matching records in Table A. This type of relationship is only possible by defining a third table, called a junction table, whose primary key consists of two fields—the foreign keys from both Tables A and B. A many-to-many relationship is really two one-to-many relationships with a third table. For example, the Orders table and the Products table have a many-to-many relationship that’s defined by creating two one-to-many relationships to the Order Details table. One order can have many products, and each product can appear on many orders.


[image: image2]
Figure 2. Many-to-many relationship

· One-to-one. In a one-to-one relationship, illustrated in Figure 3, each record in Table A can have only one matching record in Table B, and each record in Table B can have only one matching record in Table A. This type of relationship is not common because most information related in this way would be in one table. You might use a one-to-one relationship to divide a table with many fields, to isolate part of a table for security reasons, or to store information that applies only to a subset of the main table. For example, you might want to create a table to track employees participating in a fundraiser soccer game. Each soccer player in the Soccer Players table has one matching record in the Employees table.
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Figure 3. One-to-one relationship

Adding Data to Your Database

There are several methods for adding data to your database. Access 2003 provides features that can help you add data quickly and accurately. You can create a form with a customized layout to enter data using an interface that you design. This is particularly helpful when providing the form to users that are unfamiliar with databases. When adding a significant amount of data to a database manually, you may find smart tags helpful in automatically identifying fields that use similar data or that have similar properties. If your organization already has data stored in another database or application, you can use Access 2003 to incorporate data from other sources, such as Microsoft SQL Server™. You can also link to tables in external sources to incorporate the data into your database.

Building Forms to Easily View, Enter, and Change Data

To easily view, enter, and change data directly in a table, create a form. A form is a type of database object that is primarily used to enter or display data in a database. You can also use a form as a switchboard that opens other forms and reports in the database or as a custom dialog box that accepts user input and carries out an action based on the input. When you open a form, Access 2003 retrieves the data from one or more tables and displays it on the screen with the layout you choose in the Form Wizard or with the layout that you created on your own in Design view.

You create a link between a form and its record source by using graphical objects called controls. The most common type of control used to display and enter data is a text box.

You can create a form quickly by using the AutoForm command or a wizard. AutoForm creates a form that displays all fields and records in the underlying table or query. A wizard asks you questions and creates a form based on your answers. You can then customize the form the way you want it in Design view.

Using Smart Tags to Add and Modify Information

As a user, you may find yourself often performing repetitive tasks in your database such as adding several objects with many identical properties or linking data to a shared location or Web page. Access 2003 provides smart tags that can be added to any field in a table, query, form, report, or data access page in a database, as shown in Figure 4.
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Figure 4. Add smart tags to any database field

Smart tags can help you automate common data entry and lookup tasks. As you work with data in Access 2003, you may find that a field requires the same properties each time it is bound to a control in a form or report. To simplify updating the field’s properties, it would be easier to modify the common field in one location and then propagate the updates throughout all forms and reports where the field is bound to a control.

In earlier versions of Access, a field’s properties had to be modified manually in each form and report that contained a control bound to the field. Several extended properties could be inherited by controls based on that field, but the inheritance only happened when the control was created on the form or report. If updates needed to be made to the field’s properties after the field was bound to several controls, you would have to manually modify each control individually.

In Access 2003, when you modify a field property in Table Design view, the system displays a new option to update the property for all or some controls that are bound to the field, as shown in Figure 5.
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Figure 5. Propagate the property of all or some controls that are bound to an inherited field

With this feature, you can modify a field’s properties in one location and have the updates propagated to all controls bound to that field.

To add smart tags to a form

1. Open a form in Design view in Access 2003.

2. Select a text box, list box, combo box, or label.

3. Click Properties [image: image6.png]


 on the toolbar, select the Smart Tags property on the Data tab, and then click Build [image: image7.png]


.

To add smart tags to a table

1. Open a table in Design view in Access 2003.

2. Select the field to which you want to add a smart tag.

3. Select the Smart Tags property on the General tab, and then click Build [image: image8.png]


.

To select a smart tag action

After a smart tag has been added to a field or control, the Smart Tag Actions [image: image9.png]


 button appears when a cell in the field or the control is activated. Click the Smart Tag Actions [image: image10.png]


 button to see the menu of actions that are possible with the smart tag.

To propagate inherited properties

1. If the value of an inherited property is changed, the Property Update Options button appears next to the property name. Click the Property Update Options button.

2. Click the Update command.

To get more smart tags

1. Create a new form in Design view in Access 2003. 

2. Add a text box to the form, and then click Properties [image: image11.png]


 on the toolbar. 

3. Click Build [image: image12.png]


 for the Smart Tags property, and then click More Smart Tags.

Visit the Office Developer Center on the Microsoft Developer Network (MSDN®) Web site (msdn.microsoft.com/office) for more information about creating smart tags for use with Access 2003.

Incorporating Data from Other Sources

The best way to incorporate external data is to link to tables from other sources. This enables you to access data from multiple databases at one time in Access 2003 forms, reports, and data access pages. As shown in Figure 6, you can link tables from other Microsoft Office Access databases, Microsoft Excel spreadsheets, ODBC data sources, SQL Server databases, and other data sources.
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Figure 6. Access data from multiple databases at one time

In some cases, reports with linked tables or queries may run slowly. Copying a linked table into the local database is a common technique for optimizing performance for slow-running reports that use linked tables or queries. In previous versions of Access, users had to create a complex Make Table query to perform this task. Now, users can simply copy the linked table to the clipboard and paste it back into the database, as shown in Figure 7, or find this action in the task pane as a common task for Linked Tables.

[image: image14.png]Paste Table fs.

Table ame:

Lacal Table

Pese Options | B

Orked Table
O structure Only (Local Table)

© Bichns ok (v oY
© ppend D o Exing Tale





Figure 7. Copy a linked table and paste it into a database to create a local table

To make a local table

1. In the Database window, select the linked table to convert to a local table.

2. Copy the table, and then paste it.

3. Type the name for the new table in the Table Name box, and then select an option:

Paste table as a Linked Table
Paste table as an empty table (select Structure Only)

Paste table with data from the linked table (select Structure and Data)

Working with Data in Access 2003

Access 2003 includes many features to help you work with your data. Some highlights of these features include macros, automatic error correction, and queries. The following sections explore these important features.

Automating Common Tasks with Macros

Macros are a set of actions that you can create to help you automate common tasks. By using groups of macros, you can perform several tasks at once.

A macro is a set of one or more actions, and each action performs a particular operation, such as opening a form or printing a report. Macros can help you automate common tasks. For example, you can run a macro that prints a report when a user clicks a command button.

A macro can be one macro composed of a sequence of actions, or it can be a macro group. A macro group is a collection of related macros that are stored together under a single macro name. You can also use a conditional expression to determine if in some cases an action will be carried out when a macro runs.

In some cases, you may want to carry out an action or series of actions in a macro only if a particular condition is true. For example, if you’re using a macro to validate data in a form, you might want to display one message in response to one set of values entered in a record and display another message in response to a different set of values. In cases such as these, you can use conditions to control the flow of the macro.

A condition is a logical expression that evaluates to True/False or Yes/No. The macro follows different paths depending on if the condition is true or false.

Configuring Automatic Error Correction

Access 2003 includes features to help you provide the highest degree of accuracy in your database. When the AutoCorrect feature is turned on, Access 2003 automatically corrects capitalization errors and replaces text as you type with the appropriate symbols or extended statements that you configure for your database. Error-correcting smart tags are used to flag and suggest corrections for common errors on forms and reports, such as keyboard shortcut or common report errors.

Setting AutoCorrect Options

Access 2003 gives you extensive control of AutoCorrect functions, as shown in Figure 8. An AutoCorrect button appears near automatically corrected text so you can easily undo corrections—or turn AutoCorrect options on and off—simply by clicking the button and making a selection.
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Figure 8. Easily undo corrections—or turn AutoCorrect options on and off

You can also work with the Undo, Stop, and Control AutoCorrect options for each of the scenarios to reject the changes of AutoCorrect.

AutoCorrect works for the Text Box and the Combo Box controls when in Form view and for all fields when in Datasheet view.

The AutoCorrect scenarios are identified on the AutoCorrect dialog box, shown in Figure 9. Set AutoCorrect options by selecting AutoCorrect Options from the Tools menu.

[image: image16.png]AutoCorrect: English (U.S.)

AutaCorrect

Show AutoCorrect Options buttons

Cortect Two INtial Chpitals

Copitaize firstltter of sentences
Copitaize names of days

Cortect accidental use of cAPS LOCK key.

Replace text as youtype.

Replace: it
© -
4 =
(tm)

add Dekte

(e )





Figure 9. All of the selected options are automatically corrected while you type

Using Smart Tags for Error Correction

Microsoft Excel 2002 introduced the idea of using special smart tags to flag common spreadsheet errors and suggest options for correcting them. Similarly, Access 2003 flags common errors on forms and reports, and offers options for correcting them. For example, when two controls use the same keyboard shortcut (see Figure 10), or when the width of a report is greater than the page on which it will be printed, the error checking feature automatically highlights the error.
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Figure 10. Correct an error by selecting an option from the menu

     The Access 2003 error checking smart tags include:

· Unassociated Label. When a label and a control that are not associated with each other are selected, the error checking smart tag appears and offers to associate the label with that control.

· New Unassociated Label. When a label is added to a form or report, if it is not associated with a control, it is flagged and the error correcting smart tag becomes available offering to associate the label with a control.

· Unassociated Label with Accelerator (Form Only). When a label that contains an accelerator is not associated with a control, it is flagged and the user can select the error-correcting smart tag that offers to remove the accelerator or associate it with a control.

· Duplicate Accelerator (Form Only). If more than one control has the same accelerator, each control is flagged. For example, if the error checking for errors related to shortcut keys is turned on, and a control has a duplicate shortcut key assigned to it, an error indicator appears on the top left corner of the control. When the control with the error indicator is selected, the Error Checking Options button appears. Hover the mouse pointer over the Error Checking Options button, and then click the arrow that appears to display a menu that lists alternative accelerators that do not conflict, as well as an option to ignore the error.

· Invalid Control Source. If a form or report is bound and the control source is not valid (for example, if it is not spelled correctly), that control is flagged and the error checking smart tag provides options to bind that control or to bring you directly to the control source dropdown.

You can identify the types of errors Access 2003 should look for in a form or report by selecting the types on the Error Checking tab of the Options dialog box, shown in Figure 11.
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Figure 11. Selecting error checking types

     To turn on error checking

1. Select Options from the Tools menu in Access 2003.

2. Select the Error Checking tab.

3. Under Settings, select the Enable error checking check box.

To correct an error

1. Select the control that has an error indicator.

2. Hover the mouse pointer over the Error Checking Options button.

3. Click the arrow that appears in the button.

4. Select an option from the menu that appears.

Using Queries to Locate and Modify Data

To find and retrieve just the data that meets conditions that you specify, including data from multiple tables, create a query. A query can also update or delete multiple records at the same time and perform predefined or custom calculations on your data.

You can use queries to view, change, and analyze data in different ways. You can also use them as a source of records for forms and reports.

There are several types of queries in Access 2003:

· Select queries. A select query is the most common type of query. It retrieves data from one or more tables and displays the results in a data sheet where you can update the records (with some restrictions). You can also use a select query to group records and calculate sums, counts, averages, and other types of totals.

· Parameter queries. A parameter query is a query that when run displays its own dialog box prompting you for information, such as criteria for retrieving records or a value you want to insert in a field. You can design the query to prompt you for more than one piece of information; for example, you can design it to prompt you for two dates. Access can then retrieve all records that fall between those two dates. Parameter queries are also handy when used as the basis for forms, reports, and data access pages. For example, you can create a monthly earnings report based on a parameter query. When you print the report, Access displays a dialog box asking for the month that you want the report to cover. You enter a month, and Access prints the appropriate report.

· Crosstab queries. You use crosstab queries to calculate and restructure data for easier analysis. Crosstab queries calculate a sum, average, count, or other type of total for data that is grouped by two types of information—one down the left side of the data sheet and another across the top.

· Action queries. An action query is a query that makes changes to or moves many records in just one operation. There are four types of action queries:

· Delete queries. A delete query deletes a group of records from one or more tables. For example, you could use a delete query to remove products that are discontinued or for which there are no orders. With delete queries, you always delete entire records, not just selected fields within records.

· Update queries. An update query makes global changes to a group of records in one or more tables. For example, you can raise prices by 10 percent for all dairy products, or you can raise salaries by 5 percent for the people within a certain job category. With an update query, you can change data in existing tables.

· Append queries. An append query adds a group of records from one or more tables to the end of one or more tables. For example, suppose that you acquire some new customers and a database containing a table of information on those customers. To avoid typing all this information into your own database, you’d like to append it to your Customers table.

· Make-table queries. A make-table query creates a new table from all or part of the data in one or more tables. Make-table queries are helpful for creating a table to export to other Access databases or a history table that contains old records.

· SQL queries. An SQL query is a query you create by using an SQL statement. You can use a Structured Query Language (SQL) to query, update, and manage relational databases such as Access. When you create a query in query Design view, Access constructs the equivalent SQL statements behind the scenes for you.

Interacting with Other Systems

Access 2003 can use XML to interact with other systems. Through XSL transforms and verification against an updated XML schema definition language namespace, Access 2003 provides you with an effective tool for working with imported and exported data. 

Transforming Data to Schemas Used by Other Systems

Because XML is the current industry standard for importing and exporting data, the systems used in your organization may use several different XML schemas. Access 2003 enables you to transform the schema used by one set of data into the schema used by another set, using an XSL transform when exporting and importing XML.

Access in Action
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As her company’s Human Resources director, Christine uses Access 2003 to store HR data and uses another application for payroll data. On a quarterly basis, Christine adds the payroll data to the HR data to track each employee’s usage of vacation time and sick leave. The payroll application includes functionality to export data to XML, but the schema used by the payroll system is different from the schema used by

the HR system. When importing the data, Access 2003 enables Christine to transform the schema used by the payroll data into the schema used by the HR data, seamlessly merging the data.

The Import Transforms dialog box, shown in Figure 12, lists an example of previously used transforms that can be selected when importing data into Access 2003. Data stored in Access 2003 can also be transformed to another schema when exported to XML.
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Figure 12. Selecting a transform during import

Access 2003 provides a preview of the selected transformed data before it completes the import. This enables you to see if the data appears as you expected prior to your database being modified. The transformation can occur when the data is imported, before any new table is created, or when appending the transformed data to an existing table. When exporting data to XML, the transform can be applied after the export operation is completed, enabling you to ensure that the data is compatible with the current database design.

Integrating XML Data with Larger Business Processes

In a business, several systems may be used to support larger processes. Data captured in these systems may benefit from side-by-side analysis. Developers can build applications to analyze or use data captured by Access 2003. This may require the data to be exported in XML format for analysis by the application.

XML data exported from Access 2003 must be validated against the XML schema definition, which is maintained by the World Wide Web Consortium (W3C). Access 2003 uses an updated XML schema definition language namespace: www.w3c.org/2001/XMLSchema. Data type names are synchronized with the updated namespace, and developers are able to validate Access 2003 XML schemas. Microsoft Visual Studio .NET can be used to build an application that uses validated XML data exported from Access 2003.

Access in Action
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Steve is a database developer for a large Web service organization. The organization has several systems to support their business, including a server that supports the data on the sites hosted by the service, a system for detecting failures within the service, and a system for tracking site usage and user navigation paths. Steve developed an application that will automatically

compare the system failure data with the site usage data. His application compares the data and determines if heavy traffic to the site is causing it to fail consistently. Steve uses Access 2003 to validate the data from the two systems against the XML schema definition language namespace before incorporating it into his application.
Protecting Sensitive Information

You can help protect the security and integrity of your data in Access 2003 by using secure macros, blocking potentially unsafe functions, and backing up your information.

Running Macros with More Confidence

Help protect against potentially unsafe Microsoft Visual Basic® for Applications (VBA) development system code. Set the macro security level so that you’re prompted when you open a database containing VBA code, or have Access 2003 automatically block databases from unknown sources, as shown in Figure 13.
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Figure 13. Access 2003 can help give you more protection against harmful macros

          Blocking Potentially Unsafe Functions

To help enhance the security of your data, you have the option of running Access 2003 in sandbox mode. In sandbox mode, Access 2003 evaluates only those expressions in field properties and controls that are safe. An expression is considered safe if it does not use functions or properties that could be exploited by malicious users to access drives, files, or other resources for which they do not have authorization. When Access 2003 runs in sandbox mode, an expression that calls these functions or properties will result in an error message.

Note

Sandbox mode is implemented by using the Microsoft Jet Expression Service to evaluate expressions. Microsoft Jet 4.0 Service Pack 8 (SP8) or later allows Access 2003 to be fully functional, yet still have Jet block unsafe expressions by enabling sandbox mode.

However, the Jet Expression Service is not part of Access 2003. You need to download and install Microsoft Jet 4.0 SP8 or later before you can enable sandbox mode. A critical Windows operating system update includes Jet 4.0 SP8; so installing all of the critical Windows updates automatically installs the latest version of Jet on your computer.

When you start Access after installing the service pack or the critical Windows updates, you are prompted to block unsafe expressions. Clicking Yes will turn on sandbox mode and prevent unsafe expressions from being evaluated.

Backing Up Your Information

You can now back up critical database files to another location without leaving Access 2003, as shown in Figure 14. This helps prevent data loss by stopping the backup procedure if someone else is using the database at the same time. As part of the backup operation, the Compact and Repair action is performed to make sure that the database is internally consistent.

[image: image21.png]B2 Microsoft Access

Edt Vew Inert Toos Window

tew culan

open. culro

S| getexemanat ,
Close

el sove Clis
§ | savens

A escktpoatabase..

Export

File Search,

Page Setup.
Print Pregien

4| ern culp

g | e ,
Datsbase Properties

Liprogram Fies..{Northwind.mdb

Ext





Figure 14. Access 2003 provides a simple menu selection to back up your database files

3 Analyzing Your Data

Introduction

An important benefit of capturing data in a database is having the ability to easily analyze the data. Access 2003 includes several features that you can use to present your data for simple and clear analysis, including PivotTable® and PivotChart® dynamic views, snapshots of data from Windows SharePoint Services sites, and search functionality that locates object dependencies within your data. This section explores how these features can help you analyze your data.

Using Forms to Analyze Data

In many cases, the most effective way to communicate data trends for analysis is visually through a table or chart. Access 2003 enables you to view your data in a Microsoft PivotTable or a Microsoft PivotChart by simply dragging and dropping the appropriate controls. PivotTable dynamic view summarizes and analyzes your data in a data sheet or form. PivotChart dynamic view shows a graphical analysis of your data in a data sheet or form.

In both views, you can use different levels of detail. Organize data by dragging fields and items or by showing and hiding items in the drop-down lists for the fields. You can dynamically change the layout of a form to present data in different ways. You can rearrange row headings, column headings, and filter fields until you achieve the desired layout. Each time you change the layout, the form immediately recalculates the data based on the new arrangement.

Figure 15 illustrates Access 2003 data in PivotChart view.
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Figure 15. PivotChart view of Access 2003 data

With the drag-and-drop support offered in Access 2003, you can easily create compelling forms and reports that clearly communicate data trends in your organization by simply selecting to view your data in PivotTable view or PivotChart view and dragging the appropriate controls onto the form. A wizard walks you through the steps to identify the data you want to use in the table or chart.

You can customize a form in PivotTable view or PivotChart view in the following ways:

· Add, move, or remove fields. You can add fields to the filter, row, column, and detail areas in PivotTable view, and to the filter, category, series, and data areas in PivotChart view. You can also move fields from one area to another and remove fields from the view.

· Filter records. You can filter data displayed in the view by adding or moving a field to the filter area. You can also filter a field in the row and column area.

· Sort records. You can sort items in row or column fields in ascending or descending order. You can also sort items in custom order in PivotTable view.

· Group records. You can group items in row or column fields by intervals or create custom groups.

· Format elements and change captions. In PivotTable view, you can change the font settings, alignment, background color, and number format of a field. You can also change the captions of fields and custom groups. In PivotChart view, you can change the chart type, format data markers, and more.

Analyzing Data Without Interrupting SharePoint Operations

Daily operations may have several members of your organization contributing data regularly to a common SharePoint site. Effective organizations use current and historical data to plan for future business needs. Access 2003 enables you to import a list from a SharePoint site to a static database table. A new table is created that contains all of the columns that can be added to a SharePoint view, as well as all records in the list. This means that the table can be viewed and changed independently of the original list on the SharePoint site. The appropriate people in your organization can use the static data in Access 2003 to plan for future business needs without interrupting the normal data operations on the SharePoint site. For an environment in which data is frequently updated, this feature helps ensure that reporting and tracking remain accurate.

Note

It is important to note that changes made to the SharePoint site after the data has been pulled do not roll over to the static table in Access 2003. When you pull data from a SharePoint site to an Access 2003 table, you are essentially capturing a snapshot of the current data that you can modify and analyze at will. If important changes are made to the data on the SharePoint site that may affect your static data analysis, you must re-import the SharePoint data to a new Access 2003 table.

Access in Action

[image: image35.jpg]



Phil is a project manager in his organization. He makes business decisions by analyzing how his organization has performed historically, and how it is currently performing given resource constraints and workload. Phil’s organization captures project status and resource workload on a common SharePoint site, enabling each team member to see what the rest of the team is working on. Phil uses Access 2003 to import the current resource and workload data to a static table. He then uses the data in the table to help predict 

possible future resource demands, while considering potential upcoming projects, current resource availability, and historic resource performance on projects.
To import data from lists or views of a list in Windows SharePoint Services

1. In the database window in Access 2003, select the File menu.

2. Select Get external data, and then select Import.

3. Select Windows SharePoint Services from the Files of Type menu.

4. Use the Import from Windows SharePoint Services Wizard to complete the operation.

Locating Dependent Tables, Queries, Forms, or Reports

Database objects may have dependencies on other objects. For example, a form designed to capture an order may depend on a table that contains customer data and the results of a query against a table that contains product pricing.

The Object Dependencies feature of Access 2003, shown in Figure 16, helps you identify the objects in the database that the current object depends on as well as objects that depend on the current object.
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Figure 16. Object Dependencies in Access 2003

You can use the Object Dependencies pane to quickly find tables, queries, forms, or reports that depend on a particular database object.

To view dependent objects

1. Right-click a table, query, form, or report.

2. Click Object Dependencies, or select Object Dependencies from the View menu.

4 Sharing Information

Introduction

Increasing the visibility of the information you are capturing is vital to maintaining clear communication channels and getting people thinking about the implications of the trends in your data. Using Access 2003, you can easily share your data with others through reports and Web pages. Data can be shared between Access 2003 and Windows SharePoint Services, providing a flexible working environment that meets the needs of all levels of workers in your organization. In this section, you will learn how you can share your data with others effectively and efficiently.

Presenting Your Data in a Report

A report is an effective way to present your data in a printed format. Because you have control over the size and appearance of everything on a report, you can display the information the way you want to see it. For example, you might print one report that groups data and calculates totals and another report with different data formatted for printing mailing labels.

You create the link between the layout of a report and its data by using graphical objects called controls. Controls can be text boxes that display names and numbers, labels that display titles, or decorative lines that graphically organize the data and make the report more attractive.

You can create different types of reports quickly by using wizards. Use the Label Wizard to create mailing labels, the Chart Wizard to create charts, or the Report Wizard to create a standard report. The wizard asks you questions and creates a report based on your answers. You can then customize the report the way you want it in Design view.

You can customize a report in the following ways:

· Record source. Change the tables and queries that a report is based on.

· Sorting and grouping data. You can sort data in ascending or descending order. You can also group records on one or more fields and display subtotals and grand totals on a report.

· Report window. You can add or remove Maximize and Minimize buttons, change the title bar text, and manipulate other Report window elements in similar ways.

· Sections. You can add, remove, hide, or resize the header, footer, and detail sections of a report. You can also set section properties to control the appearance and printing of a report.

· Controls. You can move, resize, or set the font properties of a control. You can also add controls to display calculated values, totals, current date and time, and other useful information on a report.

Presenting Your Data on the Web

Access 2003 provides you with many ways to share your data with others on the Internet or on an intranet. You can export forms, reports, and data sheets to HTML that can be published to a Web site. You can also export tables and queries directly to a Windows SharePoint Services site.

Exporting Reports from Access 2003

Organizations can benefit greatly from having reports published to a Web site, making the data available to a larger audience for analysis. When business decisions are being made, stakeholders can quickly access a Web site to view data presented in a report format.

Access developers can design reports and publish them to the Web using XML. In Access 2002, functionality was introduced that enabled you to export a report in XML format. Two files would be generated: an XSL definition of the report and an XML version of the data. Once the files are generated, you can then publish the files to a Web site. As the data changed, you could easily republish the XML data to the Web site without needing to also republish the XSL definition.

When you create a report in Access, data is typically pulled from several tables in the database. For example, a list of sales orders may include data from tables containing the product list, order details, and other related information. Exporting the data, therefore, requires exporting the related tables. Access 2003 increases your efficiency in publishing reports by enabling you to export all of the tables with data included on the report in one action, rather than having to export each table individually. A process that may have taken a great deal of time for a very complex report has now been reduced to a single action that may take only a few minutes in Access 2003.

Using Access 2003, you can export data as XML and automatically include all related details, as shown in Figure 17. Anyone viewing the XML report can access all data from all related tables.
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Figure 17. Exporting related tables to XML

    Exporting a Table or Query to a SharePoint Site

As you work with data, it may become obvious that others could benefit from viewing the contents of a table or the results of a query on a SharePoint site. You can easily export an Access 2003 table or query to a list on a SharePoint site.

When exporting the data, simply select Windows SharePoint Services as the data type. When the Export to Windows SharePoint Services Wizard appears, as shown in Figure 18, you are prompted to enter the location of the SharePoint site to which you are exporting the data.
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Figure 18. Exporting a table or query to Windows SharePoint Services

If you have the appropriate permissions on the site, Access 2003 maps all of the field types and generates a list on the SharePoint site.

To export tables or queries to lists in Windows SharePoint Services

1. Open the database that contains the data you are exporting.

2. Select the table or query to export, and then select Export from the File menu.

3. Select Windows SharePoint Services from the Save as Type drop-down menu. 

4. Use the Export to Windows SharePoint Services Wizard to complete the operation.

          Exporting Access Data to HTML with Similar Formatting

Access 2003 enables you to produce an HTML file that maintains the appearance of the form, report, or data sheet you are exporting. This means that if you want to present a Web page that contains data from your Access 2003 database, you don’t need to spend time reformatting exported data on an HTML page.

When exporting Access data to XML, you can choose to also export a presentation XSL file, as shown in Figure 19.
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Figure 19. Export XML options

By exporting the XML data, a schema that matches the data being exported, and an XSL file, you can easily publish your Access 2003 data to a Web site, making it available for analysis by a larger audience. When the XSL option is selected, Access 2003 uses presentation information in the form, report, or data sheet to generate custom XSL code. This code produces an HTML file with a similar appearance to the original Access 2003 object. Related tables can also be exported, and any filter or sort order that is specified on the object being exported can be carried over to the HTML page.

Modifying Shared Data in Access 2003 and SharePoint

Access 2003 and SharePoint are both powerful applications with unique strengths that can be leveraged for different purposes. In some cases, it may be appropriate to share data between Access 2003 and SharePoint, enabling you to modify the data in either application and have the data automatically updated in both places. This data sharing is made possible in Access 2003 by importing SharePoint data to a dynamically linked table.

When SharePoint data is imported, Access 2003 creates a table and maintains the dynamic link between the table and the list. Changes to the table are reflected in the list, and changes to the list are reflected in the table.

Dynamic list linking makes data entry much easier and more intuitive than it was in Microsoft SharePoint Team Services 1.0. All contributing Windows SharePoint Services members can be given permission to update the Windows SharePoint Services list. As the database administrator, you can also use smart tags to check the data when the table is updated.

Access in Action


Jay, a business analyst for a large consulting firm, has identified new business rules that he would like to see rolled out to the current data on his organization’s SharePoint site. He imports the current SharePoint list to a dynamically linked table in Access 2003. Because Jay has a background in database design and is comfortable with Access, he uses Access 2003 to implement the new business rules against the

data in the list. His changes are automatically rolled out to the SharePoint site, making them immediately available to the rest of his organization.
To link to data from lists or views of a list in Windows SharePoint Services

1. In the database window in Access 2003, select the File menu.

2. Select Get external data, and then select Link Tables.

3. Select Windows SharePoint Services from the Files of Type drop-down menu. 

4. Use the Link to Windows SharePoint Services Wizard to complete the operation.

5 Help and Office Online Services

Online Help and Training

Microsoft Office Professional Edition 2003 and Microsoft Office Professional Enterprise Edition 2003 offer new and improved integration with Microsoft Office Online Web services. More powerful, better integrated, and with an improved online interface, these services are seamlessly available from within programs in the Microsoft Office System. The Web site, available at www.microsoft.com/office, offers a resource page for each Microsoft Office 2003 Editions program. These resource pages have assistance, downloads, training, and templates.

Help

The Help system of Microsoft Office 2003 Editions has been extended beyond individual workstations. If a user is connected to the Internet when choosing a Help topic or entering a word in the Ask-A-Question box, the Help system displays not only the Help information from the local system, but also brings to the Help window information from the Microsoft Office Online Web site (www.microsoft.com/office). This provides the most current information on the topic that the user needs help with, in addition to links to other resources.

Assistance

The Assistance Web page provides up-to-date information with How To articles, conceptual topics, downloads, and helpful tips for common tasks. Users can find answers to common questions, read articles on features in Office 2003 Editions, look for specific help in newsgroups, and suggest a topic for a future article.

         Office Online Training

The Training site offers Web-based interactive training courses and self-paced exercises, as shown in Figure 20. Users can develop deeper knowledge of tasks and application features, such as creating an outline in Microsoft Office Word 2003 or using motion paths in Microsoft Office PowerPoint® 2003 presentation graphics program slides. Courses include practice sessions where users can test their skill in the actual program as well as short tests to assess comprehension. Courses cover a variety of topics and are available for any Microsoft Office 2003 Editions program.
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Figure 20. Use Office Online to find training opportunities for Office programs

Downloads

On the Downloads site (formerly known as Office Update), users can check for free updates that improve the stability and security of Office 2003 Editions. On the Downloads home page, users can click Check for Updates to start the automatic detection tool, which scans the computer and then returns a list of new downloads that are available and compatible with the user's version of Microsoft Office. In addition to security and performance updates, viewers, converters, add-ins, stationery, and other useful downloads are also available. The most popular downloads are listed in the Popular Office Downloads section.

6 Summary

Access 2003 and You

Regardless of whether you are a member of a complex organization or simply a person with a large collection of rare books that you want cataloged, Access 2003 will help you easily collect information accurately and efficiently.

· Relational databases. You can store different categories of information in separate tables within an Access database and then identify relationships between the unique information in the tables, ultimately saving you time when data requires updates.

· Enhanced XML functionality for interacting with other systems. You can take advantage of the enhanced XML functionality offered by Access 2003 to interact with other systems and use the advanced security features to help keep your data safe.

· Powerful data analysis tools. When you are ready to analyze your data, Access 2003 provides you with the tools you need to view and interact with your data as a Microsoft PivotTable or PivotChart, to pull your data from a Windows SharePoint Services site and modify it independently of the live data, and to locate object dependencies within your database.

· Effortless data sharing. Access 2003 enables you to easily share your information in reports and on the Web.

· Help when you need it. Integration with Office Online provides you with the most recent Help files, online training resources, and downloads. You can get answers to your questions quickly and easily.

System Requirements

To use Access 2003, you need:

· Personal computer with a Pentium 233-megahertz (MHz) or faster processor (Pentium III recommended)

· Microsoft Windows 2000 with Service Pack 3, Microsoft Windows XP, or later operating system

· 128 megabytes (MB) of RAM or greater

· 400 MB of available hard-disk space (hard disk usage will vary according to configuration; custom installation may require more or less disk space); option installation files cache (recommended) requires an additional 290 MB of available hard-disk space

· CD-ROM or DVD drive

· Super VGA (800 x 600) or higher-resolution monitor

· Microsoft Mouse or compatible pointing device

         Additional Requirements


Additional items or services required to use certain features:

· For speech recognition: Pentium II 400-MHz or faster processor, close-talk microphone, and audio output device. 

· For certain advanced functionality in Microsoft Office Outlook® 2003:  Microsoft Exchange Server.

· For certain advanced collaboration functionality: Microsoft Windows Server™ 2003 operating system running Windows SharePoint Services.

· For Internet functionality: Dial-up or broadband Internet access provided separately. Local or long-distance charges may apply.

· For certain inking features: Microsoft Windows XP Tablet PC Edition.

· For Information Rights Management features: Access to Windows Server 2003 running Microsoft Windows Rights Management Services.

For Microsoft Office 2003 Editions complete system requirements, please visit: www.microsoft.com/office/preview/editions/sysreq.asp
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